The Industry Standard In Infrastructure Monitoring

Network Analyzer Integrating Nagios Network Analyzer With Nagios Xl And Nagios Core

Purpose
This document describes how to integrate Nagios Network Analyzer with your Nagios XI and

Nagios Core installs.

Target Audience

This document is intended for use by system admins who want to understand the different ways in which

Nagios Network Analyzer can be integrated with Nagios XI And Nagios Core.

Overview

Nagios Network Analyzer can be integrated with Nagios X| and Nagios Core, extending the capabilities of

Nagios Network Analyzer. The differences between integrating Nagios XI and Nagios Core are as follows:
* Nagios Xl
© Host and Service Status pages provide a Network Traffic Analysis tab
® Provides a pie chart and table for the past 24 hours
© Generate Reports from within Nagios Xl
© Dynamically create host and service directives received from Network Analyzer for passive checks
* Nagios Core

© Configure Network Analyzer to send passive check results to Nagios Core using NRDP

Nagios Xl - Configure Integration

In Nagios Xl you configure the Nagios Network Analyzer Integration component with the details of the Nagios
Network Analyzer server(s) that you would like integrated with Nagios XI. Integration is achieved by using an
Authentication key that belongs to a Nagios Network Analyzer user account that has been granted API
access. The first step is to get the API key that is required when configuring the component. Open Nagios
Network Analyzer as the user with APl access and then click the user's name in the top right corner of the

screen.
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Nagios

Network Analyzer™

My Profile

My Profile

Edit your profile, contact information, and account information. You may also manage your APl key.

Personal Info Account Actions API Access | Key
Your personal information and account name. Make changes to your account-specific settings. Your unigue APl key used for external APl access. You
can read more about what you can do with the APl in
Username: | readonly ™ Language = Default [~ the API documents in the help section.
Eiitl | meag & Change Password Access Level: Read-Only
TS 7314f41c330ebcd0e4Bedcbb4al5dcbbbaTT8679
Cnly
= Generate New Key
Company:
Email:
Phone:

In the screenshot above you can see the API key. Copy this into your clipboard or text file to use in the next
step. You can see that a dedicated user account has been created specifically for this purpose. The access
level this account has been granted is "User" which means it has read only access. Using a dedicated
account is a best practice, you can generate a new key if you suspect the existing key has been

compromised.

If the user account does not have an API Key on your My Profile page and it says No APl Access, you will

need to alter this user. Login as an admin user and navigate to Administration > User Management. Edit

the user and change API Access to Yes.
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Now login to Nagios Xl and navigate to Admin > System Extensions > Manage Components.

Home Views Dashboards Reporits Configure Tools Help Admin Q @ & nagiosadmin @ Logout
» System Information Core Components G
Coll=dis These are components that are required for XI to function normally. These components should not be removed or edited.

~ System Config
Component Type Settings Version

A Monitoring Config
Nagios Graph Explorer §
MNagios Graph Explorer is an interactive graphing tool for yvour Nagios data. Requires Nagios XI 2011R1.3 or later. For most reliable graphs

# Check Transfers

= y 2 i = 2.2.0
B and dashlets, use Mozilla Firefox or Google Chrome. oLs
&) Manage Components, % 2.2.0 & Nagios Enterprises, LLC
# Manage Config wizards
[0 Manage Dashlets Nagios Network Analyzer Integration
& Manage Plugins Allows you to view Nagios Network Analyzer reports in Nagios XI and allows Nagios Network Analyzer to dynamically add hosts and "
Manage Graph Templates services. Core 7 1.2.8
Manage MIBs

DT et e W 1.2.3 #907/28/2016 & Nagios Enterprises, LLC

~ System Backups Nagios XI Core Functions

Locate the Nagios Network Analyzer Integration component and click the settings & icon. The following

screenshot shows the component settings window that appears.

Nagios Network Analyzer Integration (7]

Component Settings
These are all the general settings for this component.

[] pisable Host/Service Tabs from being shown

Nagios Network Analyzer Servers
Specify the addresses and a users API Key for each of the Nagios Network Analyzer servers. These servers will be shown in the reports section as servers to run reports

on and are also allowed to send service and host directives to this Nagios X1 box for dynamic host/service creation with passive checks from inside the Nagios Network
Analyzer server.

Add a Server

Magios Network Analyzer Servers

Name: IP Address / Hostname: APl Key: Ouse Allow this host to use
|Netw0r|-c Analyzer | |ID.25.5.93 |30ebc:4l3e48e4cb54305dcbbb4??85?9| SSL Dynamic Integration

Apply Settings Cancel

Remowve

In the screenshot above click the Add a Server link to display the fields for adding a Nagios Network Analyzer

server. You can see that they have been populated, these fields will be explained on the following page.
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* Name - This is the name that you will see in the Network Analyzer Server drop-downs throughout

Nagios Xl. For example on the Network Report, Network Query Report and Configuration Wizard.

* |P Address / Hostname - The network address that Nagios X| uses to communicate with Nagios

Network Analyzer

* API Key - This is used for authentication with Nagios Network Analyzer as explained earlier
* Use SSL - Required if your Nagios Network Analyzer server is configured with SSL/TLS certificates

* Allow this host to use Dynamic Integration - This allows Nagios Xl to create host and service

directives received from Network Analyzer for passive checks (NRDP)

When you have finished populating the fields click the Apply Settings button. You can add more Network

Analyzer servers by clicking on the Add a Server link.
You can remove a server that you have previously set up if you wish by clicking on the Remove link.

If you do not want the Network Traffic Analysis tabs to be shown under the Hosts and Services details screen

in Nagios XI, check the Disable Host/Service Tabs from being shown checkbox.

This completes the initial steps for integrating Nagios Network Analyzer with Nagios XI.

Nagios Xl - Generating Reports

Generating reports from Nagios Network Analyzer in Nagios Xl is explained in detail in the following
documentation:

Integrating Nagios Network Analyzer Reports With Nagios Xl
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Nagios Xl - Network Traffic Analysis tab

Nagios Xl adds a Network Traffic Analysis tab to the host and service status pages. Here is an example from

an host object being monitored by Nagios XI:

Host Status Detail

. 10.25.14.3
1 Alias: 10.25.14.3

’ L @ Network Traffic Analysis

L3 Y ] | = ll Network Traffic Analysis

Showing the last 24 hours worth of netflow data on the selected Network Analyzer instance aggregated by source IP and destination IP and sorted by bytes.

Nagios Metwork Analyzer Server: | Network Analyzer (10.25.5.93) j Raw Query: srcip 10.25.14.3 or dst ip 10.25.14.3 (Open this query in Network Analyzer)

- v
wn My
g - S Summary Data
=] -
Ao A t;"
"] ) Total Flows Total Bytes Total Packets
1999 2.31 MB 16758

Brief Data Table (10 Records, Bytes Only)

Source IP ?:’st'"aﬂ“ Bytes Bytes/Sec
10.25.14.3 10.25.5.93 1.12 MB 109
10.25.14.3 10.25.254.50  627.31 kB 975
10.25.254.50  10.25.14.3 262.45kB 408
10.25.14.3 224.0.0.22 161.29 kB 15
10.25.14.3 224.0.0.252 | 97.30kB 9
10.25.5.13 10.25.14.3 28.01 kB 44
10.25.14.3 10.25.5.13 23.35kB | 37
10.25.14.3 10.25.255.255  16.55kB 1

See all records and details in Network Analyzer

The host being monitored has the address 10.25.14.3 and this address was found when a raw query was
performed against Nagios Network Analyzer. The pie chart shows the relationship between this address and
the other address (be it source or destination). Hovering the mouse on the addresses in the chart will put the

focus on this relationship and also highlight the data in the Brief Data Table.
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Nagios Xl - Configuration Wizard

To begin using the Nagios Network Analyzer wizard navigate via the top menu bar to Configure > Run a

configuring wizard, and select the Nagios Network Analyzer wizard. In the following screenshot you can

see how the search field allows you to quickly find a wizard.

Home Yiews Dashboards Reports Configure Tools Help Admin o & nagiosadmin & Logout =
» Configure
T Configuration Wizards - Select a Wizard & (2]
# Configuration Wizards, Start monitoring your infrastructure in minutes. Configuration wizards guide you through the process of setting up your devices, servers, applications, services, and more in
& AUTO-DTErovE Nagios XI. Select the appropriate wizard below to get started.

I Manage Templates

» Advanced Configuration
9 Show: Analyzer| 3 =

m
Ll
([}
L <]
(]
4

[ 1] Get More Wizards (2

» More Options

] Nagios Network Analyzer

NNA Monitor a source, view, or sourcegroup on a Nagios Metwork Analyzer
server.

ia.iﬁ Configuration Wizard: Nagios Network Analyzer - Step 1 &

On Step 1 you need to select the

Nagios Network Analyzer Server

NNA Server and Source Or Select one of your Nagios Network Analyzer server's source, sourcegroup, or view.

Sourcegroup that the wizard will NNA Server: | Network Analyzer (10.25.5.93) j

use |n Step 2 Host Name: | Source j FlowTraq j

Click Next to progress to step 2. ¢ Back

On step 2 you will configure all :iu“ Configuration Wizard: Nagios Network Analyzer - Step 2 &

of the options for monitoring.

Nagios Network Analyzer Server

MNMA Server: Network Analyzer (10.25.5.93)
To start off with make sure a

Host Name: NNA Source - FlowTrag
valid Host Name has been
entered. By default the format is:

NNA Source/Sourcegroup - <Selected Source/Sourcegroup Name>.
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Next you can select what to monitor. Bytes, Flows select What to Monitor

and Packets a” requ“"e Warn'ng and Cr|t|Ca| Select if you'd Iike.to m.onitor.including byte.s, flow.s, péckets and bfaha\rior DI'.I .sources.
The graph on the right is provided to help with estimating the warning and critical thresholds.
thresholds. Based off the existing data queried Defautt values are created by the following:

Warning Threshold: 20% above max value,
Critical Threshold: 40% above max value

from the source, suggested threshold values will

= Bytes
be populated. The graph underneath shows the Amount of bytes being transferred.

290617872 | bytes @ 339054184 | bytes

B,

last week of data, here you can hover the mouse to

Amount of flows being transferred.

/b, | 5372 flows @ 6267 flows

get an understanding of historic values which can

help you determine thresholds.

Packets
Amount of packets being transferred.

/i | 2013178 | packets @ 2348705 | packets

Abnormal Behavior is a check that will report if

Abnormal Behavior
If there is abnormal behavior on the source this check will return critical.

there is a pattern of behavior that is not normal

(relative to the existing history). Last Week of Bandwidth Data

300M

06/07/2017 21:30

Bytes: 95194768
Use the check boxes to deselect any checks that S Packets: 121853 ‘

Flows: 3488 ‘

you do not think are necessary.

100M

-
|| ) o ||| \ l
-'|||-'f'.'Jl||. --,\_'II,_J'IJI A, | NlL.l rh" .ll. .)fu'ulll M,JL,JI Il_,\_.|"-.|||ﬁ_||.|I|«.'ur| I\ .'lu" ﬁ";'l It s ll )

bl

C“Ck Next and then Complete the W|zard by 7. Jun 8. Jun 9. Jun 10. Jun 11. Jun 12 Jun 13. Jun

Bytes — Packets — Flows

choosing the required options in Step 3 — Step 5.

To finish up, click on Finish in the final step of the wizard.

This will create the new hosts and services and begin monitoring. Once the wizard applies the configuration,

click the View status details for xxxxx link to see the new host and services that were created.

1l Host I service 1 status [ Duration [ Attempt [ LastCheck 1 status Information

NMA Source - FlowTraq g Abnormal Behavior Ok 20m 5= 1/5 2017-05-1517:26:55 OK - No abnormal behavior detected
Bytes g,ﬁ Ok 16m 255 1/5 2017-05-1517:25:32 OK - 135473 bytes sentrecieved
Flows soh Ok 16m 42s 1/5 2017-05-1517:25:15  OK - 187 flows sentrecieved
Packets ﬂz Warning &m 35 Tt 20170515 17:24:37 WARNING - 1457 packets sentrecieved
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Nagios Xl and Nagios Core - NRDP Passive Checks

The following section applies to both Nagios XI and Nagios Core. To be able to send alerts using NRDP you

will need to do the following:
* Nagios XI
© Configure the Inbound Transfers on your Nagios XI server
* Nagios Core

© Install and configure NRDP

Please refer to the following documentation for Nagios XI or Nagios Core on how to perform these tasks:
NRDP Overview

Please take note of the NRDP Token you define in that documentation, you will need it in the following step.

In Nagios Network Analyzer navigate to Alerting and then click the Nagios Setup tab. Click the New Nagios
Server button.

Alerting

& Checks B Nagios Setup SNMP Receivers = Commands

B New Service/Hostname B pew MNagios Server

Servicename Hostname Assoclated Server Actions Name NRDP Address NRDP Token Actions
Mo associations created. Mo servers created.

1295 Bandana Blvd N, St. Paul, MN 55108 sales@nagios.com US: 1-888-624-4671 INTL: 1-651-204-9102

uagios@’ www.nagios.com

© 2017 Nagios Enterprises, LLC. All rights reserved. Nagios, the Nagios logo, and Nagios graphics are the servicemarks, trademarks, or
registered trademarks owned by Nagios Enterprises. All other servicemarks and trademarks are the property of their respective owner. Page 8 /17

Updated — February, 2019



mailto:sales@nagios.com
https://assets.nagios.com/downloads/nrdp/docs/NRDP_Overview.pdf
https://www.nagios.com/

The Industry Standard In Infrastructure Monitoring

Network Analyzer Integrating Nagios Network Analyzer With Nagios Xl And Nagios Core

Here you need to provide the details of your

Nagios Xl or Nagios Core server. Enter Information

Enter information about the Nagios Server.
Name - The human-readable name used to Name | Nagios XI
refer to this Nagios server in alerts.
NRDFP Address http://10.25.5.13/nrdp/
NRDP Address - The address that NRDP NRDP Token | hiluNSuOpoZ3
results will be sent to. Be sure to include the

http:// or https:// part as well.

Cancel Finish & Save

NRDP Token - The token that Network

Analyzer will attempt to use to connect to the NRDP server.

Network Analyzer validates your NRDP server settings by attempting to connect with the NRDP server right
away, and if it cannot connect to the server or the token provided is invalid, it will warn you. Once added the

screen will update reflecting this.

& Checks B njagios Setup # SNMP Receivers = Commands

Successfully created Nagios server.

B New Service/Hostname B new Nagios Server
Servicename Hostname Associated Server Actions Name NRDP Address NRDP Token @ Actions
Mo associations created. MNagios X1 = hitp://10.25.5.13/nrdp/  hfiuNSulpo23  View / Edit  Delete

Now that the Nagios Server has been defined you now need to define a Service/Hostname that the NRDP

passive checks will be sent to on your Nagios Server. Click the New Service/Hostname button.
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Servicename - The name of the service that the

Enter Information
alert will be sent to in Nagios Xl or Core.

Enter information about the Servicename/Hostname.

Servicename Source Working

Hostname - The name of the host object that you
want the service to be assigned to in Nagios Xl or Hostname | 10.25.14.3

Core.

on

Server Magios XI j
Server - The Nagios Xl or Core service you want

the alert to be sent to.

Cancel Finish & Save

Click the Finish & Save button to create the

Service/Hostname object. The screen will update like the following:

& Checks B Nagios Setup # SNMP Receivers £ Commands

Successfully created Hostname/Servicename. If you are using Nagios XI, log into Nagios XI and apply the new config.

B nNew Service/Hostname B New Nagios Server
Servicename Hostname Associated Server Actions Name NRDP Address NRDP Token Actions
Source Working 10.25.14.3 Magios XI View / Edit  Delete Nagios XI http://10.25.5.13/nrdp/ hfiuNSuOpo23 View / Edit Delete

As per the notification, if your Nagios server is a Nagios Xl server AND you have Dynamic Integration enabled
all you need to do now is go into Core Configuration Manager in Nagios X| and apply configuration. This will
create the new host and service objects ready to accept passive check results. If for some reason the
services are not created, once the check in Network Analyzer has been created, the services will appear

under Unconfigured Objects in Nagios XI (Admin > Monitoring Config).
If you have Nagios Core, you will need to create your own passive services to accept these check results.

Details on how to do this are outside the scope of this documentation however on the following page is a

simple example:
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define service {
service description
host name
use
active checks enabled
passive checks enabled
flap detection enabled
check period
max check attempts
check interval
retry interval
check freshness
contact groups
notification interval
notification period

notification options

Integrating Nagios Network Analyzer With Nagios Xl And Nagios Core

Source Working
10.25.14.3
generic-service
0

1

0

24x77

(@R L

admins
60
24x7

w,u,c,r

The last remaining step is to define an alert so Nagios XI or Nagios Core will receive check results. The

following example creates an alert that will notify if a source has no flow data received on the port that the

flow data is being received on. Click the Checks tab and then click the New Check button.

Alerting / Checks

Alerting

& Checks B Magios Setup  # SNMP Receivers

Name Associated With

Mo checks created.

Last Status

= Commands

Last Date Ran Last Stdout Actions
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Step 1
Step 1 - Select Source
You must enter a name for the check for P

management/organizational purposes. It can _
Please name the check for management: (Required)

contain only whitespaces and alphanumeric Flow Data 2055
characters.
@ Source () Sourcegroup
Then you need to select your source or source Source
group. This is the source the check will get values FlowTraq 7

View

Mo View j

from. If you select a source, you can select a view

to test against as well.

Click the Step Two button to proceed to Step 2. cancel
Step 2

Analyze traffic for - This is the metric you would Step 2 - Select Criteria

like to get the number for to check against. If you

want a packet count, pick Packets. If you want total Analyze trafficfor: | Flows h

bytes, pick Bytes. There are several other options, Warning threshold is: | 1:

but the point is there are multiple dimensions to the ortical threshoid is: | 1

traffic on your network, and this specifies which one

will be checked. Where The: Destination j
Port j

Warning and Critical - Once Network Analyzer @ s

has extracted a number from the metric you O s not

selected, it will use these thresholds to determine if
the number is in a WARNING, CRITICAL or OK

state. In this example 1: means that if less than 1 And

(required) | 2055

was received then it will be in a CRITICAL state

Cancel £ Step One Step Three

(meaning no flows were received).
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More detailed information on thresholds is explained in the Nagios Threshold Values section of this document.

The bottom half of step 2 is how you filter what data the check is looking at, this allows granularity.

In the screenshot on the previous page, Flows is the type of traffic being analyzed. The filter criteria used is:

* Destination - The direction of the flow traffic being looked at

* Port - This check testing to make sure flow data is actually being received, seeing as the flow data is

received on a port then this makes it easy to check

* is - This is the operation, we want to make sure the destination port IS 2055

* 2055 - Here the port number 2055 has been defined

Based on those selections, if no flow data is received it will be in a CRITICAL state, otherwise it will be OK.

You can specify as many of these filters as you would like by clicking the And button at the bottom. It will add
a new box where you can specify additional filters. Please note that it is a Boolean AND, where the traffic

must meet all specifications that are chosen for the check to be used.

Click the Step Three button to proceed to Step 3. Step 3 - Select Alerting Methods

Select how you would like to be notified of these checks. Select any of the items in the
Here you select the alerting method. In this example lists under the tabs, and all the selected elements will be notified.
the Nagios tab has been selected and the Emall Users ~ Naglos  SNMP Traps  Commands
Servicename/Hostname that was previously defined Select the Host/Service associations you would like to send the check results as.

Removing: Held ctrl and click to un-select Host/Services.

has been selected.

Click the Finish and Save button to create the

alert.

Cancel € Step Two Finish & Save
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The check will be created and will appear on the screen in a pending state:

Alerting

& Checks B Nagios Setup # SNMP Receivers £ Commands

=+ Mew Check
Name Associated With Last Status Last Date Ran Last Stdout Actions
Flow Data 2055 FlowTrag PEMNDING N/A View / Edit » Delete

Here is an example of the check when it had a CRITICAL state:

Name Associated With  Last Status Last Date Ran Last Stdout Actions

Flow Data 2055  FlowTraq _ 2017-05-15 21:35:10  flows on FlowTraq with filter "dst port 2055’ is 0 | flows=0;1:;1:;0 View / Edit = Delete

Here is an example of the check when it had a OK state:

Name Associated With  Last Status Last Date Ran Last Stdout Actions

Flow Data 2055  FlowTrag OK 2017-05-15 21:40:10  flows on FlowTraq with filter "dst port 2055’ is 3 | flows=3;1:;1:;0 View [ Edit » Delete

Here is the service in Nagios when it had a CRITICAL state:

1l Host 1 service 1 status || Duration [ Attempt I LastCheck 1 status Information

10.25.14.3 g :.a‘ Source Working 3:3,93 - 34s iM 2017-05-16 10:40:10 flows on FlowTrag with filter "dst port 2055 is 0
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Here is the service in Nagios when it had an OK state:

Host Service Status Duration Attempt Last Check Status Information
1 s s s s 1 1

10.25.14.3 ﬂ g.a‘ Source Working giyﬁ Ok im4ds 1M 2017-05-16 10:35:10 flows on FlowTrag with filter "dst port 2055 is 1

The checks are run every five minutes, it's important to understand that every five minutes the check will fire
off a notification to Nagios XI or Nagios Core. Based on the WARNING and CRITICAL thresholds you defined

on the check, Nagios will receive the check results with the state from the check.

Note: If the services did not appear in Nagios Xl after applying configuration, the services will appear under
Unconfigured Objects in Nagios XI (Admin > Monitoring Config).

Home Views Dashboards Reports Configure Tools Help Admin ¥ & nagiosadmin (% Logout =

» System Information
»~ Users UI"ICOI‘IfigI.II'ed Objects o

~ System Config This page shows host and services that check results have been received for, but which have not yet been configured in Nagios.
Passive checks may be received by NSCA or NRDP (as defined in your inbound transfer settings) or through the direct check submission API.
w Monitoring Config
You may delete unneeded host and services or add them to your monitoring configuration through this page. Note that a large amount of persistant unused passive checks can
Config Snapshots result in a performance decrease.
Check File Permissions
NRD on ger

g Mang
Unconfigured Objects

Clear Unconfigured Objects List

Deadpool Settings [] Hest Service Last Seen Actions
A Check Transfers = 2017-05-16 10:30:23 X p
O 10.25.14.3
~ System Extensions Source Working 2017-05-16 10:30:23 3

» System Backups
With Selected: 3

Check the box on the left and click the gear icon below to run the Unconfigured Objects wizard. More
information on Unconfigured Objects can be found in the following documentation:
Monitoring Unconfigured Objects With Xl
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Leveraging The API

You can also query the check results directly from the API. Here is an example using the query defined in the

previous section (assuming you are already logged into Nagios Network Analyzer):

http://na_ip address/nagiosna/index.php/api/checks/read?q[name]=Flow$20Data%202055

This will return JSON output:

[{"cid":"1", "rawquery":"dst port 2055","name":"Flow Data

2055", "warning":"1:", "sid":"1","gid":null, "vid":null, "active":"1","critical":"1:
", "aberrant™:"0", "lastval":"1","lastrun":"2017-05-16

10:50:10","lastcode":"0", "laststdout":"flows on FlowTrag with filter "dst port

2055° is 1 | flows=1;1:;1:;0","metric":"flows","assoc with":"FlowTraqg"}]

You can also use a curl command from another machine, however this requires your API key to be submitted

with the token argument, for example (this is one long command):

curl -g "http://na ip address/nagiosna/index.php/api/checks/read?
token=7314f41c330ebc40ed48e4cb64a05dcbbb4778679&q [name]=Flow%20Data%202055"

When used in a script you can programmatically access the data in the JSON object and do what you like
with it.
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Nagios Threshold Values

Nagios Thresholds can be complicated to initially understand, however once grasped they can be very

powerful. Documentation on Nagios thresholds is available here:

https://nagios-plugins.org/doc/quidelines.hitmi#THRESHOLDFORMAT

The Nagios Threshold standards were designed with many different use cases, for example negative
numbers are valid values. However in the case of Nagios Network Analyzer, the alert value being tested will

always be 0 or greater (no negative numbers are involved).

Network Ports

The following network ports are used for communication between Nagios Network Anaylzer and Nagios Xl or

Nagios Core:

* Nagios Xl Integration communicates with the Nagios Network Analyzer server on TCP 80 or 443

* Nagios Network Analyzer when using NRDP for sending passive check to Nagios XI or Nagios Core
occurs on on TCP 80 or 443

Finishing Up
This completes the documentation on integrating Nagios Network Analyzer With Nagios XI And Nagios Core.

If you have additional questions or other support related questions, please visit us at our Nagios Support

Forums:
https://support.nagios.com/forum
The Nagios Support Knowledgebase is also a great support resource:

https://support.nagios.com/kb
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